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1. Intended Use 
 

qEEG-Pro web application is to be used by qualified mental healthcare professionals for the statistical 

evaluation of the human electroencephalogram (EEG) of patients between 4 and 82 years of age. 

Intended for use in clinical settings, qEEG-Pro web application aids in the assessment of brain 

activity, supporting decision-making in neurological evaluation and therapy planning but is not 

intended for use as a standalone diagnostic tool. 

2. Potential Adverse Effects 
 

Potential adverse effects of the use of the device are known if the qEEG-Pro is used as a stand-alone 

diagnostic system in the absence of other clinical data from more traditional means of patient 

evaluation. Relying only upon the use of a single index (such as relative power or the topological 

maps alone) without reviewing the traditional EEG, the epochs selected for analysis, or the complete 

set of statistical summary tables is also contraindicated and a source of potential error. Additional 

sources of error could arise from selecting EEG representative of other states, such as drowsiness or 

eyes-open EEG when comparing to an eyes closed database. Additionally, it is possible that errors will 

occur through the purposeful falsification of symptoms in the patient history and patient age. Any 

serious incident that has occurred in relation to the device should be reported to the manufacturer 

and the competent authority of the Member State in which the user and/or patient is established. 

3. Precautions 
 

a. Ensure patient data confidentiality and compliance with relevant data protection regulations. 

b. Use the service in conjunction with other clinical assessments and diagnostic tools. 

c. Review the qEEG report in the context of the patient's overall clinical picture. 

d. Data Retention and Archiving: Results older than two years (including PDF reports, Excel tables, 

and other output files) may be archived and no longer directly accessible through the platform. If 

you need to retrieve older results, please reach out to support@qeeg.pro. Retrieval costs will 

apply due to the manual operations required to restore archived data. 

4. Contact Information 
 
qEEG-Pro BV 
Verdunplein 17, 5627 SZ  
Eindhoven, The Netherlands 
Mail: support@qeeg.pro 

  

mailto:support@qeeg.pro
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5. Logging Into the qEEG-Pro Web Application 
 

Navigate to https://app.qeeg.pro/login and use the username and password given to you by the 

qEEG-Pro sales representative. 

6. News Section 

The News section in qEEG-Pro provides important updates regarding the platform, new features, 
improvements, and relevant research developments. This section ensures that users stay informed 
about enhancements to the service and any changes that may impact their workflow. 

What You Can Expect in the News Section: 

a. Feature Updates: Information on new functionalities added to the platform, including 
improvements to report generation, analysis tools, and user interface enhancements. 

b. Service Announcements: Notifications regarding scheduled maintenance, system upgrades, 
or temporary downtimes. 

c. Research & Developments: Summaries of relevant scientific publications, updates on qEEG 
research, and insights into best practices for EEG-based assessments. 

d. Pricing & Subscription Changes: Announcements regarding updates to pricing models, new 
subscription options, or modifications to existing service plans. 

e. Important Policy Updates: Changes in data retention policies, compliance requirements, or 
regulatory adjustments that may affect users. 

Users are encouraged to regularly check the News section to stay up to date with the latest 
developments. 

7. Setting Up Your Account in the qEEG-Pro Dashboard 
 

When you have logged into the qEEG-Pro web application , you can go to the personal settings by 

clicking on the avatar in the top-right corner of your screen.  

This reveals the following options: 

1. Language Setting 

You can select the language of the application (currently only English is available). 

2. Personal Report Profile 

The Personal Report Profile feature in qEEG-Pro allows users to customize the z-score scaling 

and normal z-score range for the Linked Ears and Laplacian reports. 

1. Z-Score Scaling 

By default, the z-score scaling is set to -3 ≤ Z ≤ 3. This means that the z-scores 

are scaled between -3 and +3. You can adjust this scaling according to your 

specific requirements. 

2. Normal Z-Score Range 

https://app.qeeg.pro/login
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The normal range settings help define what is considered 'normal' in your 

plots. Z-scores within this normal range will appear in a grey color.   

3. Report Selections 

By default, all analyses are included in the selection. You can deselect 

specific analyses or entire reports to customize your qEEG analyses. 

 

3. Registering Your Device 

In the ‘Devices’ menu, you can register your EEG amplifier device using the serial number of 

the device. You can register a maximum of two devices. Registering your device(s) will result 

in unlimited EEG credits when you have a Gold or Platinum subscription. Whenever you 

upload an EEG, the system will compare the serial number embedded in the EDF file with the 

serial number(s) entered in the Devices menu of your account. When the serial number of 

the EDF file does not match the serial number(s) entered in your account, the entry will 

generate an error message and the EEG file will not be processed. 

 

4. Company Logo 

In the ‘Company Logo’ menu, you can change the default qEEG-Pro logo that appears in all 

the reports on the top-right of each page to a custom logo. You can choose an image file 

(.jpg, .jpeg, .png, .bmp) using the file selection tool. Clicking ‘update’ will confirm your choice, 

and the logo you uploaded will be used in all future qEEG-Pro reports. 

 

5. Account Settings 

In the ‘Account settings’ menu, you can update your name, password, email address, avatar 

image and you can set whether you would like to receive email notifications from qEEG-Pro. 

6. Signing Out 

You can click on the ‘sign out’ button to sign out of your account. 

8. Managing User Accounts in qEEG-Pro 

The Users section in qEEG-Pro allows organization administrators to create and manage user 
accounts with different access rights. Each user will receive their own login credentials, ensuring 
secure and role-specific access to the system. 

1. Adding a New User 

To add a new user, follow these steps: 

a. Navigate to the Users Section 

i. In the left-side menu, click on Users under the qEEG-Pro dashboard. 

b. Click on "Create" 

i. Select the "Create" button to open the user creation form. 

c. Enter User Details 
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i. Fill in the required fields, including: 

• First Name (Required) 

• Middle Name (Optional) 

• Last Name (Required) 

• Email Address (Required – This will be used for login and notifications) 

• Username (Required – This will be the unique identifier for the user) 

• Password (Required – A secure password for login) 

d. Select User Level 

i. Assign the appropriate User Level from the available options: 

• Organization Admin – Has full access to the system, including managing 

users, uploading EEG data, generating reports, and overseeing 

administrative tasks. 

• Therapist – Can create client entries, upload EEG data, and generate 

reports, but does not have administrative rights. 

• Planner – Can create client entries, but cannot upload EEG data or 

generate reports and does not have administrative rights. 

 

e. Email Notification Preferences 

i. Choose whether the user should receive email notifications regarding system 

updates or patient reports. 

ii. Set User Status 

iii. Ensure the status of the user is active to allow login access. 

iv. Click "Create" 

Once all fields are filled, click Create to finalize the user account. The new user will now have 

access to the system according to their assigned role. 

2. Managing Existing Users 

a. To edit user details, navigate to the Users section, select the user, and update their 
information. 

b. To remove a user, administrators can deactivate their account to restrict access. 

By properly assigning roles, qEEG-Pro ensures that each team member has the appropriate level 
of access, maintaining data security and streamlined workflow management. 

9. Creating a Client Entry 
 

To create a new client entry, follow these steps: 

1. Navigate to the ‘Clients’ Menu  

On the left side of the screen, click on ‘Clients’. This will display a list of all previously entered 

clients. 

2. Create a New Client  
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In this screen, click on the ‘Create’ button to open a form for adding a new client. You will 

need to provide: 

a. A client code, which can be any numerical sequence between 1 and 12 digits. Please 

make sure to save this ID in your records to prevent any potential mix-ups. 

b. The gender of the client. 

c. The handedness of the client (right, left, or ambidextrous). 

3. Submit the Form  

Once all required fields are completed, click on ‘Create’ to proceed to the next step. 

4. Add a Treatment Entry  

In the following screen, you can create a treatment entry for the client. Every client must 

have at least one active treatment associated with them. Click ‘Create’ to open the 

treatment form. 

5. Set Treatment Details 

a. Define the start date and, if necessary, the end date of the treatment. The end date 

can be left blank for ongoing treatments. 

b. Select the user associated with the treatment from the list of registered users in your 

qEEG-Pro account (refer to Section … for instructions on adding users). 

c. The status of the treatment is set to ‘open’ by default, but you can change it to 

‘closed’ when the treatment is completed. 

6. Finalize the entry  

After filling in the treatment details, click ‘Create’ one final time to complete the new client 

entry. 

10.    Preparing Your EEG Recording File 
 

1. EEG Amplifier Compatibility 

The qEEG-Pro web application is compatible with the following devices: 

ANT Neuro EEGO24 
BeeMedic NeuroAmp  
Brainmaster Discovery 
Cadwell Apollo  
Cadwell Easy 2 
Cognionics Quick 20 
Deymed TruScan 
EGI NA400 
Elmiko ExG-32 and 1042 series (No Neuroguide reports) 
Freedom 24/20/10 (For Freedom 10 files, no sLORETA reports can be generated) 
J&J Neuronavigator  
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Medicom Encephalan-EEGR-19/26 
Memory MD NeuroEEG  
MindMedia Nexus 
Mitsar 
Natus XLTEK 
Neuracle  
Neuroelectrics StarStim 
Neurofield Q20 
Neuroscan 
Neurosoft Neuron-Spectrum 
PNI  

 
2. The EDF File Format 

The qEEG-Pro web application  only accepts EEG files in the EDF format. Please contact the EEG 
amplifier manufacturer to assist you with exporting your EEG file to the EDF format. 

 
3. Recording Duration 

The minimum duration of an EEG recording is 30 seconds. However, it is recommended to use 

recording durations of at least 6 minutes in order to get valid and robust qEEG analyses results, 

provided that the EEG recording does not contain excessive amounts of artifacts. 

4. Sampling Frequency 

The minimum sampling frequency of an EEG recording is 128Hz. The following sampling 

frequencies are allowed: 128Hz, 200Hz, 250Hz, 256Hz, 300Hz, 400Hz, 500Hz, 512Hz, 1000Hz. 

5. File Size 

The maximum file size is 20MB per file. The file size of an EDF file is dependent on the recording 

duration and the sampling frequency.  

6. Required Channels 

For all amplifiers except the Freedom 10 amplifier, the following channels are required: FP1, FP2, 

F7, F3, Fz, F4, F8, T3, C3, Cz, C4, T4, T5, P3, Pz, P4, T6, O1 and O2. 

7. Montage 

The qEEG-Pro web application requires the EEG recordings to have the ‘Linked Ears’ montage. 

8. Filtering 

Ideally, EEG recordings would be unfiltered. However, using a high-pass filter setting with a 

cutoff of a maximum of .5Hz and a low-pass filter setting with a cutoff of a minimum of 50Hz 

should also deliver valid qEEG results. However, caution is needed when using filters before 

uploading to the qEEG-Pro Report Service. Using a high-pass filters may result in lower 

amplitudes in the Delta band (1-4Hz) and using low-pass filters may result in lower amplitudes in 

the Gamma band (>30Hz). 

11.    Uploading an EEG Recording File 
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Once you have successfully created a client entry with an active treatment, follow these steps to 

upload and process an EEG: 

1. Navigate to the ‘EEG(s)’ Menu  

On the left side of the screen, click on ‘EEG(s)’. 

2. Click on ‘Upload EEG’  

This option is located on the right side of the screen. 

3. Select the Client  

You’ll be taken to a screen where you can select the client entry for whom you want to 

process an EEG file. 

4. Complete the Form 

Some fields, like Gender and Handedness, will already be filled. Make sure to fill out all the 

other relevant fields: 

a. Age 

Specify the age of the client at the time of the recording. 

b. Eyes condition 

Specify whether the EEG was recorded with eyes open or closed. 

c. EEG amplifier  

Select the amplifier used to record the EEG. 

d. Neuroguide 

i. Neuroguide report  

Check this option if you'd like a Neuroguide report included. 

ii. TBI (Traumatic Brain Injury) Discriminant Analysis  

Available only for eyes closed and clients aged 13+. 

iii. Learning Discriminant Analysis  

Available only for eyes closed, clients aged 6-18, and without a history of TBI. 

These results will be added to the Neuroguide report if selected. 

e. Optional outputs 

i. NIFTI files  
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Choose to generate NIFTI files for use with MRICron (see chapter ’ NIFTI files 

for MRICron’ for details on how to use these files). 

ii. Excel Tables  

Select to receive the analysis results in numerical form in Excel tables. 

iii. EEG Dynamics Analysis  

Optionally, request a report on microstates and entropy. 

f. Artifact Removal  

By default, the automatic artifact removal algorithm (SARA) is set to ‘yes’. 

You can turn it off by selecting ‘no’, but it is not recommended unless the 

EEG has already been cleaned, as artifacts can influence qEEG measures and 

lead to errors in interpretation. 

5. Select the EEG Montage  

By default, you will receive a report with the raw EEG signal in the linked ears montage. You 

can also request reports using the longitudinal or transversal montage. 

6. Upload the EDF File  

Click on ‘Attach files’ to select your EEG file (EDF format). Note that the maximum file size is 

20 MB, and you can upload only one EDF file at a time. 

7. Submit the Form  

Once you’ve filled out all fields and attached the EDF file, click on ‘Upload and Send’. The file 

will be uploaded to our processing servers, where it will be automatically analyzed, and 

reports will be generated. 

8. Processing Time  

The processing time typically ranges from 30 to 60 minutes, depending on the file size and 

server workload. 

9. Check the Status  

After uploading, you’ll be redirected back to the ‘EEG(s)’ menu, where your latest entry will 

appear at the top of the list. Once the status changes from ‘processing’ to ‘results’, you can 

click the ‘results’ button to download your reports. 

12.    qEEG-Pro Reports (Client Information) 
 

At the left top of each report, you’ll find the following client-specific details: 
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1. EEG ID  

The unique identifier for the client. 

2. Test Date  

The date of the EEG recording. 

3. Age  

The client's age. 

4. Gender  

The client’s gender. 

5. Montage  

The type of montage used for the EEG analysis. 

6. Eyes Condition  

The state during the recording. 

13.    qEEG-Pro Reports (SARA Report) 
 

 

 

 

 

 

 

The SARA (Standardized Artifact Rejection Algorithm) Report displays the EEG signal as well as the 
artifacts that were detected.  
 
Segments containing artifacts will be marked in the SARA report and removed before the qEEG 
analyses are performed. By default, two SARA reports are generated: one for the ‘Linked Ears’ 
montage and one for the ‘Laplacian (CSD)’ montage. Additionally, you can choose to receive SARA 
reports for the ‘Longitudinal’ and ‘Transversal’ montages as well. The de-artifacted EEG recording will 
also be made available for download in the .EDF file format. More on the algorithms underlying the 
detection of the different artifacts can be found in Appendix 1.   
 
SARA is designed to identify and exclude artifacts from EEG recordings, ensuring the integrity and 
accuracy of qEEG-Pro analysis. The algorithm operates as follows: 
 

1. Artifact Detection and Marking 
The algorithm targets various types of artifacts, including: 

a. Type 1 Frontal Deflections 
i. Filters the EEG data to isolate specific frequency ranges associated with 

these deflections. 
ii. Computes indices by comparing specific EEG channels. 

iii. Marks segments where the amplitude exceeds a predefined threshold. 
b. Type 2 Frontal Deflections 

i. Calculates differences between specific EEG channels. 
ii. Marks segments where the amplitude exceeds a predefined threshold. 

c. Low-Frequency Artifacts 
i. Filters the data to isolate low-frequency artifacts. 

ii. Marks segments where the amplitude exceeds a predefined threshold. 
d. High-Frequency Artifacts 
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i. Filters the data to isolate high-frequency artifacts. 
ii. Marks segments where the amplitude exceeds a predefined threshold. 

e. Flat Line Detection 
i. Detects segments with minimal signal variation. 

ii. Marks these segments as artifacts. 
2. The Fitting Algorithm 

The fitting algorithm is employed to prevent edge artifacts at the beginning and end 
of each segment marked for rejection 

3. Removal of Segments Marked as Artifacts 
The segments marked as artifacts are removed from the EEG recording. 

4. Writing the SARA File 
Writes out only the artifact-free segments to the SARA file in EDF format 

5. Error Handling 
Includes robust error handling mechanisms to identify and report errors such as no 
signal, invalid EEG files, and channel detection errors. 

  

14.    qEEG-Pro Reports (Surface Analyses) 
 

The qEEG-Pro Reports (surface analyses) display EEG measurement results compared to the means 

and standard deviations of the qEEG-Pro database, matched to the patient's age. By default, two 

qEEG-Pro Reports (surface analyses) are generated: One for the Linked Ears montage and one for the 

Laplacian (CSD) montage. For a detailed description of the calculations underlying section 4b-4s of 

the qEEG-Pro report, the reader is referred to Appendix 2. 

 

1. Client  Information, Reliability Assessment and Artifact Rejection Results 

 

a. Client Information 

This section includes basic demographic and recording information: 

i. Patient ID  

This field is intentionally left blank so that the user can enter a patient/client 

ID or patient/client name after the report has been downloaded to the user’s 

computer. 

ii. EEG ID  

Unique identifier for the EEG recording generated by the system 

iii. Age  

Client’s age at the time of recording. 

iv. Gender  
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Gender of the client (male/female/undifferentiated). 

v. Handedness  

Indicates whether the client is right-handed or left-handed. 

vi. Condition  

Specifies the state during recording (Eyes Open or Eyes Closed). 

vii. EEG Amplifier  

The device used for recording (e.g., BrainMaster Discovery). 

b. Reliability Assessment 

The Split-Half Reliability column provides a measure of consistency for each EEG 

channel: 

i. Values range from 0 to 1, with higher values indicating more reliable data. 

ii. Channels with values close to 1 are considered highly reliable. 

iii. If the reliability score is low, it could signal poor data quality or excessive 

noise in that channel. 

c. Artifact Rejection Results 

This section details the data cleaning process performed by SARA: 

i. Noisy Channels  

Lists channels with high-frequency artifacts. These artifacts have been 

automatically identified and marked in the SARA report. High-frequency 

artifacts have not been removed from the recording for these channels. 

ii. Percentage Rejected Data 

Indicates the proportion of data removed due to artifacts. A high rejection 

percentage may reflect poor signal quality or significant artifacts during 

recording. 

iii. Record Length 

The total length of the recording session. 

iv. Edit Length 

The amount of data that remains after artifact rejection. 

 

2. Summary 
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In section 2 of the qEEG-Pro report, a summary of the Z-scored results is depicted. topoplots of the 
following analyses are depicted for the Delta, Theta, Alpha, Beta and Gamma band: 
 

a. Absolute Power 
b. Relative Power 
c. Amplitude Asymmetry 
d. Phase Coherence 
e. Phase Lag 

 
 
3. FFT Absolute Power 

 

In section 3 of the qEEG-Pro report, topoplots of the absolute power (in microvolts squared) are 

depicted for each 1 Hz frequency bin, starting with 1 Hz and ending with 40 Hz. Each frequency bin 

ranges from -.5 to =.5 Hz. For example: The 12 Hz bin ranges from 11.5 to 12.5 Hz.  

 

 

4. Z-scored FFT Absolute Power 

 

In section 4 of the qEEG-Pro report, topoplots of the Z-scored absolute power are depicted for each 1 
Hz frequency bin, starting with 1 Hz and ending with 40 Hz. The sample of the normative database 
consists of 200 subjects that have the lowest age difference compared with the age of the client, 
with an ‘age resolution’ of 6 months.  

 

5. Z-scored FFT Relative Power 

 

In section 5 of the qEEG-Pro report, topoplots of the Z-scored relative power are depicted for each 1 
Hz frequency bin, starting with 1 Hz and ending with 40 Hz. Relative power is calculated with the 
following formula, where RP is Relative Power, AP is Absolute Power and  f is frequency. 
 
 

 

 

 
6. Z-scored Power Ratio 

 
In section 6 of the qEEG-Pro report, topoplots of the following Z-scored Power Ratios are depicted: 
 

a. Delta/Theta 
b. Delta/Alpha 
c. Delta/Beta 
d. Delta/HiBeta 
e. Theta/Alpha 
f. Theta/Beta 
g. Theta/hiBeta 
h. Alpha/Beta 
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i. Alpha/hiBeta 
j. Beta/hiBeta 

 
 
7. Burst Metrics  

 
In section 7 of the qEEG-Pro report, the Z-scored Burst Metrics are depicted. The analysis of Burst 
activity is calculated in several steps. First, the second derivative of the power in 9 frequency bands 
was calculated. In this time series, peaks in power are defined by the points in time in which the 
value of the second derivative turns from positive to negative. After the peak power detection, 
bursts were identified by the evaluation of two criteria. The first criterion evaluates the duration of 
the full-width half-maximum (FWHM) around a peak in the power within a frequency band of 
interest. When the FWHM is larger than 2* and smaller than 10* the average cycle duration of the 
center frequency within a frequency band of interest, the first criterion is met. The second criterion 
evaluates the difference between the power at the start of the burst period and the peak power of 
the burst period. When this difference exceeds the median band power + 1* the standard deviation, 
the second criterion is met. The following metrics are derived from the periods in which both criteria 
are met: 
 

a. Average Peak Power 
b. Bursts per second (number of burst periods divided by the duration of the recording in 

seconds) 
c. Full Width Half Maximum (average FWHM of the burst periods) 
d. Inter Burst Interval (average duration between burst periods) 

 

8. FFT power distribution and Alpha peak frequency 

 

In section 8 of the qEEG-Pro report, a topoplot is depicted, showing the FFT results for each channel. 

A red, vertical line represents the frequency at which the Alpha peak frequency (APF) was detected. 

The exact Alpha peak frequency is shown on the right of this line.   

 

9. Z-scored Alpha peak 

 

In section 9 of the qEEG-Pro report, a topoplot is depicted, showing the z-scores of the APF. A 

positive z-score reflects a higher APF and a negative z-score reflects a lower APF, relative to the norm 

group.  The table next to the topoplot shows the channel, APF and Z-scored APF (Z-APF) is shown. 

Deviant z-scores (>2.3 or <-2.3) are marked in color. The alpha peak detection algorithm uses the first 

derivative to detect whether the slope of the FFT power distribution is positive or negative in the 

range of 7 to 13 Hz. The power of the peak frequency of the frequency ranges that exhibit a rising 

slope are compared and the peak frequency exhibiting the maximum power is considered the alpha 

peak frequency. 

 

10. Z-scored Phase Coherence 

 
In section 10 of the qEEG-Pro report, plots of the Z-scored phase coherence are depicted for each 1 
Hz frequency bin. Blue and red lines represent z-scores below and above a z-score of -2.3 and 2.3, 
respectively.  
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 Phase coherence is calculated using the following formula, where PH is phase coherence, x 
and y are the EEG signals from two electrodes, f is frequency and P is (cross) power spectral density.  
 
 
 
 
 
 
 
11. Z-scored Amplitude Asymmetry 

 
In section 11 of the qEEG-Pro report, plots of the amplitude asymmetry z-scores are depicted for 
each 1 Hz frequency bin. Blue and red lines represent z-scores below and above a z-score of -2.3 and 
2.3, respectively.  
 Amplitude asymmetry is calculated using the following formula, where AA is amplitude 
asymmetry, ax and ay are the amplitudes of the EEG signals from two electrodes and f is frequency. 
Adding 100 is to ensure the amplitude asymmetry is a positive value, which is necessary for applying 
the log-transform. 
 

 

 

12. Z-scored Phase Lag 

 
In section 12 of the qEEG-Pro report, plots of the Phase Lag z-scores are depicted for 9 frequency 
bands. Phase lag is calculated in several steps. First, band pass filtering is applied to the EEG signal 
which filters out the frequencies around the frequency band of interest. Next, new EEG signals are 
created by summing the filtered EEG signals for all possible electrode combinations. Phase lag is 
calculated by calculating the exponential of the ratio between the sum of the power of the EEG signal 
of two channels of interest and the power of the summed signal of these two channels. For a 
detailed description of the rationale behind this approach, see ‘Technical Foundations of 
Neurofeedback’ by Thomas F. Collura (2013). 
 
13. Comodulation (Cross-frequency power correlations) 

 

Section 13 of the qEEG-Pro report contains the individual comodulation analysis (also called Cross-

frequency power correlations). Power fluctuations within the recording of each 1 Hz bin are 

correlated with the whole frequency spectrum (1-40 Hz). The resulting heat plot represents the 

correlations between all 40 X 40 possibilities. The red diagonal line that is present in all of these 

heatplots represents the correlations between identical power bins, which are always 1. As a 

reference, the Alpha Peak Frequency is marked with a white cross (Eyes Closed condition only). 

The frequency autocorrelations analysis can be used to identify harmonics or functionally 

coupled frequency bands. For example, when the z-score analyses reveals that there is both an 

excess of 10 Hz and 20 Hz power on occipital sites, one may hypothesize that the excess of 20 Hz 

power can be explained by harmonics. Looking at the frequency autocorrelations at occipital sites 

can confirm this hypothesis when there is a high positive correlation between 10 Hz and 20 Hz.  
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Furthermore, this analysis can be used to determine the width of a frequency band that will 

be used for Neurofeedback training. For example, if there is an excess of 13-14 Hz and the frequency 

autocorrelations analysis reveals that the frequencies between 12 and 18 Hz show a high positive 

correlation, one may safely decide to set the frequency bandwidth for Neurofeedback training 

between 12 and 18 Hz. On the other hand, a theta-beta Neurofeedback protocol in which the theta 

band is down-trained and the beta band is up-trained is not recommended when these frequencies 

are highly positively correlated.  

 

14. Extreme Z-score Development 

 

Section 14 of the qEEG-Pro report contains the results of the extreme z-score development analysis. 

For 9 frequency bands the frequency is analyzed in which the most extreme z-score is found. The left 

panels show headplots which are scaled to the maximum and minimum z-score within that 

frequency. The right panels show the result of the age simulation analysis. The x-axes of these graphs 

represent the actual age of the client, marked with a red vertical line, and the simulated ages, 

ranging from -5 years to +5 years in .5 year increments, respective to the actual age. The blue lines 

indicate the change in z-score when the age of the client is artificially changed. This analysis indicates 

whether the severity of deviant activity that a client shows increases or decreases when the client 

ages and the EEG stays the same. For example, when a client shows an excess of frontal theta activity 

at the age of 10 years old, and the Extreme Z-score Development analysis shows that this activity 

would be less deviant at a younger age and more deviant at an older age, one may conclude that this 

deviant activity is the result of a ‘maturation lag’.  

 

15. Fluctuation Time 

 

Section 15 of the qEEG-Pro report contains the results of the Fluctuation Time analysis. In this 

analysis, power fluctuations respective to the median power is calculated 9 frequency bands. Next, 

the average duration between two crossings of the median is calculated. By definition, the average 

duration above the median threshold is identical to the average duration below the median 

threshold. This analysis can be used to study the variability of the power for a frequency bin of 

interest and may function as a guide for setting the time above or below threshold criterion in 

Neurofeedback protocols.  

 

Illustration of the calculations underlying the Fluctuation Time analysis. Panel A is 
an example of power fluctuations (blue line) which have a relatively long average 
time above/below the median threshold (black line, red bars), while panel B is an 
example of power fluctuations which have a relatively short average time 
above/below the median threshold. 

 

 

 

16. Percentage Deviant Activity 

 

Section 16 of the qEEG-Pro report contains the results of the Percentage Deviant Activity analysis. In 

this analysis, the power fluctuations are compared with the normative database. The percentage of 
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the time in which the z-score is above or below 2.3 is calculated. When the z-score analyses for an 

electrode site and frequency bin depicted on page 2 and 3 is positive, the percentage from 0 up 

to100 percent is scaled from green to red (0 up to 100 percent). When the z-score analyses for an 

electrode site and frequency bin depicted on page 2 and 3 is negative, the percentage from 0-100 

percent is scaled from green to blue (0 down to -100 percent). The reason a z-score cutoff value of 

2.3 was chosen is that this z-score value corresponds with a p-value of .001, which is a commonly 

used threshold for comparisons that are uncorrected for multiple comparisons in neuroscience 

literature.  

 
17. Tables: Amplitude 

 

Section 17 of the qEEG-Pro report shows two tables containing the Absolute Power and the Relative 
Power data as well as the Z-scored Absolute Power and Relative Power data respectively. Deviant z-
scores (>2.3 or <-2.3) are marked in color. 
 

18. Tables: Amplitude Asymmetry 

 
Section 18 of the qEEG-Pro report shows two tables containing the top and bottom 10 Amplitude 
Asymmetry data and the z-scored Amplitude Asymmetry, for 4 frequency bands: 
 

a. Delta (1:3Hz) 
b. Theta (4:8Hz) 
c. Alpha (8:12Hz) 
d. Beta (15:20Hz) 
e. Gamma (35-45Hz) 

 
Deviant z-scores (>2.3 or <-2.3) are marked in color. The top and bottom 10 Amplitude Asymmetry z-
scores are shown in topoplots.  
 

19. Tables: Phase Coherence 

 
Section 19 of the qEEG-Pro report shows two tables containing the top and bottom 10 Phase 
Coherence data and the z-scored Phase Coherence, for 4 frequency bands: 
 

a. Delta (1:3Hz) 
b. Theta (4:8Hz) 
c. Alpha (8:12Hz) 
d. Beta (15:20Hz) 
e. Gamma (35-45Hz) 

 
Deviant z-scores (>2.3 or <-2.3) are marked in color. The top and bottom 10 Amplitude Asymmetry z-
scores are shown in topoplots. 
 

15.    qEEG-Pro Reports (sLORETA Source Reconstruction) 
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Source reconstructions for all discrete frequencies between 1 and 45 Hz for all EEGs in the qEEG-Pro 
database were performed using standardized low resolution brain electromagnetic tomography 
(Pascual-Marqui, 2002). For each EEG, two sLORETA reports are generated.  
 

1. Summary  

 
The sLORETA Summary contains the results of the Extreme Z-score Analysis. For 9 
frequency bands the frequency is shown in which the most extreme z-score is found. The 
left panels show the transverse, coronal and sagittal slices (from left to right) of the MNI 
template in which the most extreme z-score is found. The voxel that shows the most 
extreme z-score is marked with a crosshair. On the right of each frequency band, the 
brain area and Brodmann area is depicted of the voxel that shows the most extreme z-
score. Moreover, the functions and possible symptoms of defect which are associated 
with that brain area are shown. 

 
 

2. Discrete Frequencies 

 
The sLORETA report contains the z-scored sLORETA results for each discrete frequency 
between 1 and 45 Hz. Each page shows the results for a selection of slices in the 
transverse plane of the MNI template brain.  

 

16.    Dynamics Report 
 

1. Microstate Analyses Report Overview 

 

The Microstate Analyses report provides a detailed breakdown of the microstate activity 

in a client's EEG. Microstates are short periods of stable, distinct brain activity patterns 

that repeat across time. This analysis compares the client's individual microstate patterns 

to a database average, allowing for clinical interpretation based on deviations from 

normative data. 

a. Individual Topography 

The left side of the report shows the Individual Topography of the client's 

microstates (A, B, C, and D). These maps depict the distribution of electrical 

activity across the scalp during the four canonical microstate patterns. 

Microstate A to D: Each microstate reflects a distinct pattern of brain activity that 

repeats over time. The color patterns represent the electrical potentials, where 

red indicates positive potentials and blue indicates negative potentials. 

b. Database Average Topography 
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On the right, the report displays the Database Average for the same microstate 

patterns (A, B, C, and D). This serves as a reference for comparison against the 

client’s individual topography. 

c. Microstate Profiles 

Below the topographical maps, you’ll find a detailed table of metrics that 

compare the client’s microstate activity to the database norms. This section 

provides a breakdown of key variables related to the microstate patterns. 

i. Duration 

The average length (in milliseconds) of each microstate when it occurs.  

ii. Z-Duration  

The Z-score of the duration, indicating how the client’s duration deviates 

from the database average. Positive Z-scores indicate longer than 

average durations, and negative Z-scores indicate shorter durations. 

iii. Occurrence  

The frequency at which each microstate occurs, measured in Hz.  

iv. Z-Occurrence  

The Z-score of occurrence, showing how the client's occurrence rate 

compares to the norm. 

v. Coverage  

The percentage of time each microstate occupies during the recording.  

vi. Z-Coverage  

The Z-score of coverage, which compares how much time the client's 

brain spends in each microstate relative to the norm. 

vii. MeanGFP 

The mean Global Field Power (GFP) represents the overall strength of 

brain activity during each microstate. 

viii. Z-MeanGFP  

The Z-score of the GFP, indicating how the client’s GFP compares to the 

norm. 

d. Explained Variance 

i. Explained Variance 
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This value  indicates how much of the total brain activity is explained by 

the four canonical microstates. 

ii. Z-Explained Variance  

The Z-score for explained variance shows how this value compares to the 

normative database. 

e. Additional Information 

At the bottom of the report, the methods used for band-pass filtering and 

microstate sorting are referenced. The EEG was filtered between 2Hz and 17Hz 

and re-referenced to the average reference to align with standard practices in 

microstate research. 

 

2. Entropy Analyses Report Overview 

 

The Entropy Analyses report provides a detailed evaluation of the complexity and 

irregularity of the brain's electrical activity (EEG) through different entropy measures. 

Entropy reflects the amount of disorder or unpredictability in the signal, and various 

types of entropy analyses offer insights into the dynamical complexity of the brain’s 

activity patterns. This report presents three different types of entropy measures and 

compares the client's data with normative data using Z-scores. 

17.    NIFTI files for MRICron  
 

You can apply 3D rendering techniques to qEEG-Pro data by using MRIcron. To begin, select the 

“Generate NIFTI files for MRIcron” option in the EEG upload screen on qEEG-Pro. Once selected, 

NIFTI files will automatically generate and be available for download in the MRIcron results tab. 

1.     Download and Set Up MRIcron 

 

a. Download MRIcron  

Go to nitrc.org and search for “MRIcron.” Choose the appropriate version for your operating 
system (Windows, macOS, or Linux), agree to the license, and download the file. 

b. Install MRIcron  

Unzip the downloaded file and open the folder. Double-click the “MRIcron” application to 
launch the software. 

2.     Open NIFTI Files in MRIcron 

https://www.nitrc.org/
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a. Open the Anatomical Template  

In MRIcron, go to File > Open and navigate to the downloaded qEEG-Pro results files. You’ll 
find several NIFTI files, including anatomical templates and source reconstruction maps. 
Begin by selecting the “skull-stripped anatomical template” file to load a standard brain 
template. 

b. Overlay Z-score Maps  

To add a frequency map (e.g., 17 Hz) from the source reconstruction data, go to Overlay > 
Add and choose one of the Z-score maps. The map will overlay onto the anatomical 
template. 

3.     Adjust Display Settings 

a. Color Smoothing  

For better color representation, go to View and deselect “2D Smooth All.” 

b. Set Thresholds  

Adjust the lower and upper thresholds to highlight areas of interest. For example, set the 
lower threshold to 2.4 and the upper threshold to 3.0 to display significant deviance levels. 

c. Color Scheme  

Select “Warm” from the color scheme options to enhance visualization. 

4.     Create a 3D Render 

a. Render the Image  

To generate a 3D rendering, go to Window > Render. This window shows a 3D view of the 
brain template with the Z-score map superimposed. 

b. Generate High-Resolution Images  

Press the red arrows button for a high-resolution rendering of the displayed image. This 
enhances image quality, which can be helpful for presentations or reports. 

5.     Manipulate and Save the 3D Image 

a. Rotate and Adjust View  

In the rendering window, you can rotate the brain model and view slices to see internal 
structures. 

b. Shading and Cutout Options  
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Add shading or use the “Cutout” option (View > Show Cutout) to focus on specific brain 
areas. Adjust the cutout plane as needed to display the Z-score area clearly. 

c. Save the Image 

Once satisfied with the render, save the image by going to File > Save as Bitmap. You can 
save it as a PNG or bitmap file. 

 

MRIcron offers numerous features for visualizing and analyzing qEEG data in 3D. We encourage you 

to explore the software further to fully utilize its capabilities. 

 

18.  Therapist Rating Scale 

 

The Therapist Rating Scale is an essential tool within the Psychological Assessment tools, 

allowing clinicians to systematically assess and document a client’s symptom profile. This 

rating helps in generating neurofeedback protocol recommendations tailored to the client’s 

specific needs. 

1. How to Use the Therapist Rating Scale 

a. Accessing the Therapist Rating Scale 
i. Navigate to the Psychological Assessment menu. 

ii. Click on Therapist Rating. 
b. Selecting the Client 

i. Click on ‘Create’ 
ii. Choose the client for whom you want to create a therapist rating. 

c. Selecting Symptoms 
i. The Therapist Rating Scale includes the following symptom categories: 

• Attention Deficit Disorder 

• Depression 

• Anxiety Disorder 

• Obsessive Compulsive Disorder 

• Autism 

• Schizophrenia 

• Memory Disorder 

• Sleep Disorder 

• Epilepsy 

• Substance Addiction 

• Traumatic Brain Injury 

• Tinnitus   
• Dyslexia 
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ii. Symptoms can be rated on a scale, indicating severity or presence. 
iii. Each symptom category can be marked as a ‘Primary Symptom To Treat’. 

This means that for these symptom categories, a Neurofeedback protocol 
recommendation will be created when requesting a Protocol 
Recommendation Report. 

d. Click on ‘Create’ to add the Therapist Rating to the client. 

 

 

e. Medication and Substance Use 
i. At the bottom of the scale, there are fields for medications and substance 

use: 

• Stimulants 

• Antidepressants 

• Anxiolytics/Sedatives 

• Antipsychotics 

• Anticonvulsants 

• Alcohol 

• Cannabis 

• Opiates 
 

ii. Medication/Substance use can be rated on a scale, indicating frequence of 
use or dose, depending on the substance. 

a. Finalizing the Rating 

i. After selecting the relevant symptoms and medications, click ‘Create’. 
ii. The Therapist Rating Scale is now saved and can be used for the Protocol 

Recommendation Reports and the qEEG Profile Reports. 

19.  DSM-Based Questionnaire 
 

The DSM-Based Questionnaire is a powerful tool within qEEG-Pro that allows clinicians to collect 

structured symptom assessments from their clients. This information is essential for generating 

Protocol Recommendation Reports, qEEG Profile Reports and gaining insight into the client’s 

condition. The questionnaire contains 88 questions based on the DSM (Diagnostic Statistical Manual) 

for the same symptom categories as the aforementioned Therapist Rating Scale, in addition to 

questions about substance and medication use. 

 

1. How to Use the DSM-Based Questionnaire 

a. Accessing the DSM-Based Questionnaire 

i. Navigate to the Psychological Assessment menu. 
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ii. Click on DSM-Based Questionnaire. 

b. Selecting the Client 

i. Click on ‘Create’ 
ii. Choose the client for whom you want to create a DSM-Based 

Questionnaire entry and click on ‘Create’ again. 
iii. The entry is now completed. Click on the ‘Link’ button and you will get the 

option to either copy the link or open the questionnaire page by clicking on 
the link. You can share the link with your patient using your own emailing 
system, or you can have the client fill out the questionnaire at your 
computer by opening the questionnaire page directly. 

iv. You can view the progress of your patient under ‘progress’. Once the 
questionnaire has been filled out completely, you can use it for the 
Protocol Recommendation Reports and the qEEG Profile Reports. 

20.  Disorder-Specific Questionnaires 

The Disorder-Specific Questionnaire Module in qEEG-Pro provides a set of validated self-report 
assessments designed to evaluate symptoms associated with various psychological and neurological 
conditions. These questionnaires complement qEEG data by offering additional insight into a client's 
symptoms, allowing for a more comprehensive assessment of brain function. The questionnaires are 
available as part of the Psychological Assessment Subscription and include: 

1. Adult ADHD Self-Report Scale (ASRS) – Assesses symptoms of attention-deficit/hyperactivity 
disorder (ADHD). 

2. Generalized Anxiety Disorder-7 (GAD-7) – Measures the severity of generalized anxiety 
symptoms. 

3. Patient Health Questionnaire-9 (PHQ-9) – Screens for symptoms of depression. 
4. Autism Quotient-20 (AQ-20) – Evaluates traits associated with autism spectrum disorder 

(ASD). 
5. Obsessive-Compulsive Inventory-Revised (OCI-R) – Measures symptoms of obsessive-

compulsive disorder (OCD). 
6. Pittsburgh Sleep Quality Index (PSQI) – Assesses sleep disturbances and sleep quality. 
7. Rivermead Post-Concussion Symptoms Questionnaire (RPQ) – Screens for cognitive and 

physical symptoms following traumatic brain injury (TBI). 
8. Tinnitus Handicap Inventory (THI) – Evaluates the impact of tinnitus on daily functioning. 
9. Everyday Memory Questionnaire-Revised (EMQR) – Measures subjective memory complaints 

in daily life. 
10. Promodal Questionnaire-Brief (PQB) – Screens for early symptoms of psychosis. 
11. Alcohol and Substance Use Questionnaire – Assesses the use of psychoactive substances and 

their potential impact on cognition and mental health. 

Each questionnaire has been extensively researched and validated in scientific literature, ensuring 
high reliability and clinical relevance. The results from these assessments are integrated into the 
qEEG Profile Report and Protocol Recommendation Report, where symptom severity is mapped onto 
qEEG biomarkers to aid in personalized treatment recommendations. 
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1. How to Use the Disorder-Specific Questionnaires 

a. Accessing the Disorder-Specific Questionnaires 

i. Navigate to the Psychological Assessment menu. 
ii. Click on Disorder-Specific Questionnaires. 

b. Selecting the Client 

i. Click on ‘Create’ 
ii. Choose the client for whom you want to create a Disorder-Specific 

Questionnaires entry. 
iii. Enter the current age of the client 
iv. Select one or more of the available questionnaires. Note that the 

Substance Use questionnaire will be selected by default and cannot be 
deselected. 

v. Click on ‘Create’. 
vi. The entry is now completed. Click on the ‘Link’ button and you will get the 

option to either copy the link or open the questionnaire page by clicking on 
the link. You can share the link with your patient using your own emailing 
system, or you can have the client fill out the (set of) questionnaire(s) at 
your computer by opening the questionnaire page directly. 

vii. You can view the progress of your patient under ‘progress’. Once the 
questionnaire has been filled out completely, you can download the pdf 
report containing the results and/or use it for the Protocol 
Recommendation Reports and the qEEG Profile Reports. 

 

2. Clinical Considerations 

1. Not a Standalone Diagnostic Tool – The questionnaires should always be used 
alongside clinical interviews and behavioral observations. 

2. Patient-Specific Adjustments – Some individuals may over-report or under-report 
symptoms, so clinicians should interpret scores within the full clinical picture. 

3. Progress Tracking – Re-administering questionnaires over time helps monitor 
treatment effects and patient improvement. 

21.    Neuropsychological Tests  

The Neuropsychological Testing Module in qEEG-Pro provides a set of validated cognitive 
assessments designed to evaluate different aspects of brain function. These tests can be used in 
combination with qEEG data to gain a more comprehensive understanding of cognitive strengths and 
weaknesses. The tests are available as part of the Psychological Assessment Subscription and include: 

1. Continuous Performance Test (CPT) – Measures sustained attention and impulse control. 
2. Corsi Block Tapping Test – Assesses visuospatial working memory. 
3. Stroop Test – Evaluates selective attention and cognitive flexibility. 
4. Rey’s Visual Design Learning Test – Measures immediate visual memory span. 
5. Emotion Recognition Test – Tests the ability to identify facial expressions of emotion. 
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6. Finger Tapping Test – Assesses fine motor speed and coordination. 

Each of these tests provides quantitative performance metrics, which are displayed in the results 
report alongside z-score comparisons to age-matched normative data. 

1. How to Use the Neuropsychological Tests 

c. Accessing the Neuropsychological Tests 

iii. Navigate to the Psychological Assessment menu. 
iv. Click on Cognitive Test. 

d. Selecting the Client 

viii. Click on ‘Create’ 
ix. Choose the client for whom you want to create a Neuropsychological Tests 

entry. 
x. Enter the current age of the client 

xi. Select one or more of the available tests. 
xii. Click on ‘Create’. 

xiii. The entry is now completed. Click on the ‘Link’ button and you will get the 
option to either copy the link or open the test page by clicking on the link. 
You can share the link with your patient using your own emailing system, 
or you can have the client complete the (set of) test(s) at your computer by 
opening the questionnaire page directly. 

xiv. You can view the progress of your patient under ‘progress’. Once the tests 
have been completed, you can download the pdf report containing the 
results.  

2. Continuous Performance Test (CPT)  

 

• The CPT is used to assess sustained attention and impulse control, making it 
particularly relevant for ADHD, traumatic brain injury (TBI), Alzheimer’s disease, 
schizophrenia, and bipolar disorder. 

Test Procedure: 

• Letters appear one at a time on the screen at a rate of one letter per second. 
• The subject must press a button only when the letter “B” appears. 
• The test consists of 200 trials and takes about 5 minutes to complete. 

Results Interpretation: 

• Misses (%): Instances where the letter “B” appeared but no response was 
recorded. 

• False Alarms (%): Incorrect button presses for non-target letters. 
• Reaction Time (ms): The average time taken to respond to correct targets. 
• The z-score scale indicates how far the subject’s performance deviates from the 

norm. Higher misses or false alarms may indicate attention difficulties or 
impulsivity. 
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3. Corsi Block Tapping Test 

 

• The Corsi Block Tapping Test measures visuospatial working memory, which is crucial 
for problem-solving and planning. It is often used in cases of frontal lobe dysfunction, 
psychotic disorders, and depression. 

Test Procedure: 

• A set of colored blocks is presented on the screen. 
• The blocks light up in a sequence, and the subject must reproduce the sequence in 

the correct order. 
• The sequence starts at 2 blocks and increases in difficulty. 
• The longest sequence correctly recalled at least twice in three attempts is recorded 

as the Corsi Span. 

Results Interpretation: 

• Corsi Span Score: Indicates the maximum number of blocks the subject could 
correctly recall. 

• Lower scores may indicate impairments in working memory, associated with frontal 
and parietal cortex dysfunction. 

 
 

4. Stroop Test 

 

• The Stroop Test evaluates selective attention and cognitive flexibility. It is widely 
used for assessing ADHD, TBI, and schizophrenia. 

Test Procedure: 

• Subjects are presented with color words (e.g., "Blue," "Green") where: 
o In the congruent condition, the ink color matches the word (e.g., “Blue” 

in blue ink). 
o In the incongruent condition, the ink color does not match the word 

(e.g., “Blue” in red ink). 
• Subjects must quickly decide whether the word matches the ink color and 

respond accordingly. 

Results Interpretation: 

• Reaction Time (ms): Average response time across different conditions. 
• Error Percentage (%): Frequency of incorrect responses. 
• A higher reaction time and error rate in incongruent conditions may indicate 

cognitive inflexibility or attention deficits. 

 
5. Rey’s Visual Design Learning Test 
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• This test assesses visual memory and is used for identifying neurodegenerative 
disorders (e.g., Alzheimer’s disease) and memory deficits associated with 
hippocampal dysfunction. 

Test Procedure: 

• Part 1: Subjects view 15 abstract figures sequentially and must remember them. 
• Part 2: Subjects are shown 30 figures and must decide whether they have seen 

them before. 

Results Interpretation: 

• Error Percentage (%): Incorrectly identified or missed figures. 
• High error rates may suggest memory impairments due to hippocampal or 

temporal lobe dysfunction. 

 
 

6. Emotion Recognition Test 

 

• This test evaluates the ability to recognize emotions from facial expressions and is 
often used in autism spectrum disorder (ASD), post-traumatic stress disorder (PTSD), 
and schizophrenia. 

Test Procedure: 

• Short video clips show neutral faces gradually morphing into one of six emotions: 
o Anger, Disgust, Happiness, Sadness, Surprise, Fear. 

• The subject must select the correct emotion at different levels of difficulty. 

Results Interpretation: 

• Error Percentage (%): Accuracy in recognizing each emotion. 
• Higher error rates may indicate difficulties in emotional processing, particularly 

in social cognitive disorders. 

 
 

7. Finger Tapping Test 

 

• This test measures fine motor speed and coordination and is commonly used for 
TBI, Parkinson’s disease, and stroke assessment. 

Test Procedure: 

• The subject taps a button as fast as possible for 10 seconds using their: 
o Right hand (3 trials). 
o Left hand (3 trials). 

• The total number of taps is recorded. 
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Results Interpretation: 

• Number of Taps per Hand: Average performance across trials. 
• Large differences between hands or very low scores may indicate motor 

impairment. 

 

22.    qEEG Profile Report 
 

 

1. How to request a qEEG Profile Report 

 

a. Navigate to the Profile Report Section 

 In the left-hand menu, click on ‘Profile Report’. 

b. Initiate the Report Request 

 Click on the ‘Request Report’ button located on the right side of the screen. 

c. Select Client 

 Choose the client for whom you want to generate the report. 

d. Choose the Basis for the Report 

 You will have three options: 

i. Disorder-Specific Questionnaire 

ii. DSM-Based Questionnaire 

iii. Therapist Rating 

After selecting one of these options, you will be prompted to choose the specific 

questionnaire or therapist rating entry. If multiple entries are available, select the one you 

want. 

e. Select EEG Recordings 

i. Choose the Eyes Open recording. 

ii. Choose the Eyes Closed recording. 

f. Submit the Request 

 Once all fields are filled, click the ‘Request Report’ button at the bottom of the 

 screen. 

g. Download the Completed Report 

 The report will be generated and made available for download as soon as possible. 

 

2. qEEG Profile Report: Cover Page 
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a. Name (optional)  

This field is intentionally left blank so that the user can enter a client ID or 

client name after the report has been downloaded to the user’s computer. 

b. Date of Recording 

The date the EEG was recorded. 

c. Age, Gender and Handedness 

Key demographic details. 

 

3. qEEG Profile Report: Introduction 

This section provides a summary of: 

a. Client Symptoms  

Based on a questionnaire completed by the client or a therapist's rating scale. 

b. EEG Recording Details  

Information about the EEG amplifier, sampling frequency, and recording 

duration for both eyes open and eyes closed conditions. 

c. Raw EEG Sample 

Additionally, a raw EEG sample is displayed to provide an overview of the 

recording quality. 

4. qEEG Profile Report: Surface Amplitude Results 

This page highlights the client’s brain activity in five classic frequency bands: 

a. Delta (0.5–4 Hz) 

b. Theta (4–8 Hz) 

c. Alpha (8–12 Hz) 

d. SMR (12–15 Hz) 

e. Beta (15–30 Hz) 

Each frequency band provides insight into normal or abnormal brain activity, along with 

relevant clinical correlations. 

5. qEEG Profile Report: EEG Biomarker Match 

The EEG Biomarker Match graph shows: 

a. Psychopathology Ratings per Disorder 

The red bars reflect the client-reported symptoms. 

b. EEG Biomarker Match per Disorder 



   

Version 1.8.1 
 

32 

The green segments illustrate the percentage EEG biomarker match with a particular 

disorder 

The transparency of the green bars reflects the level of scientific support: 

i. Opaque: Strong scientific backing. 

ii. Transparent: Weaker support, requiring cautious interpretation. 

 

6. qEEG Profile Report: EEG Biomarker Scale 

This page includes two key graphs: 

a) Pathology Scales: 

i. Visualizes deviations in brain activity metrics (e.g., theta power, alpha 

asymmetry). 

ii. The thickness and proximity of bars to the center indicate scientific support. 

b) Arousal Scales: 

i. Measures arousal levels. 

ii. High arousal shows increased beta/gamma activity; low arousal correlates 

with higher delta/theta/alpha activity. 

iii. The thickness and proximity of bars to the center indicate scientific support. 

 

7. qEEG Profile Report: Resting State Networks 

 

This section uses source localization techniques (e.g., sLORETA) to map and identify 

dysregulated brain activity within functionally integrated neural networks.  

The following networks are part of the ‘Resting State Networks’ section: 

• Default Mode Network 

• Dorsal Attention Network 

• Emotion Regulation Network 

• Sensory-Motor Cortex 

• Memory Network 

• Visual Cortex 
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For each network, the following measures are presented: 

 

a. Network Activity 

Each Brodmann area that is part of the resting state network can show normal 

activity (green), hyperactivity (purple), hypoactivity (blue) or abnormal activity 

(orange). 

i. Cortical hyperactivity: Characterized by an excess in the power of high-frequency 

neural oscillations (e.g., >15 Hz).  

ii. Cortical Hypoactivity: A deficit in high-frequency activity and/or an excess in low-

frequency neural oscillations (e.g., <12 Hz). 

Abnormal activity is determined when there is an excess in both high-frequency and 

in low-frequency neural oscillations, or when there is a deficit in both high-frequency 

and in low-frequency neural oscillations. 

 

b. Network Connectivity 

In addition to assessing local brain activity, this analysis examines the phase coherence 

between brain areas, a measure of the integrity of functional communication within 

networks. Dysregulated connectivity is classified as either: 

i. Hyper-connectivity: Excessive synchronization between brain areas.  

ii. Hypo-connectivity: Reduced synchronization between brain areas.  

 

c. Arousal 

The arousal thermometer graph displays the level of arousal based on the cortical 

arousal measured with the relationship between the power of low and high frequencies, 

as well as the general role of the network in arousal  

 

d. Pathology and Clinical Relevance 

The analysis considers deviations in network activity and connectivity to determine 

patterns of cortical pathology: 

i. Normal: Balanced network activity within standard ranges. 

ii. Elevated: Mild to moderate deviations in brain activity. 

iii. High: Significant abnormalities in brain activity. 
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23.    Protocol Recommendation Report 
 

The Protocol Recommendation Reports in qEEG-Pro allow you to generate tailored neurofeedback 
protocols based on EEG data and client information. Follow the steps below to create and access 
these reports: 

 
1.     How to request a Protocol Recommendation Report 

 

a. Navigate to the Protocol Recommendation Section 
 In the left-hand menu, click on ‘Protocol recommendation’. 

b. Initiate the Report Request 
 Click on the ‘Request Report’ button located on the right side of the screen. 

c. Select Client 
 Choose the client for whom you want to generate the report. 

d. Choose the Basis for the Report 
 You will have three options: 

i. Disorder-Specific Questionnaire 
ii. DSM-Based Questionnaire 

iii. Therapist Rating 
 
After selecting one of these options, you will be prompted to choose the specific 
questionnaire or therapist rating entry. If multiple entries are available, select the 
one you want. 

e. Select EEG Recording 
Choose the EEG recording entry, which can be either eyes condition (open or closed) 

The report includes the following sections: 

2. Protocol Recommendation Report: Cover Page 

a. Name (optional)  

This field is intentionally left blank so that the user can enter a client ID or client name 
after the report has been downloaded to the user’s computer. 

b. Date of Recording 

The date the EEG was recorded. 

c. Age, Gender and Handedness 

Key demographic details. 

3. Protocol Recommendation Report: Overview 
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a. Psychopathology Rating 

This section shows ratings based on the Therapist Rating Scale or Client 
Questionnaire. If a protocol recommendation has been requested for a particular 
psychopathology, it will be printed in italics and the page number where the 
recommendation is given will be printed next to it. 

b. Substance Use 

This section shows the degree to which different categories of psychoactive 
substances are currently  used by the client. 

c. General Information 

This section shows some general information about the client and the characteristics 
of the EEG recording that was used to create the protocol recommendation(s). 

d. Relevant EEG Biomarker Overview 

Here, a list of EEG biomarkers is presented and whether they were present in the 
qEEG results of the client. 

 

4. qEEG-Informed Protocol Recommendation 

 

a) Protocol Recommendations 
The core of the report consists of recommended neurofeedback protocols based on the 
patient's qEEG results and reported symptoms. The protocols are divided into three 
categories: 

i. Classic Neurofeedback (Amplitude Training) 

• Specifies target frequency bands and electrode sites (e.g., increasing 
9-11 Hz on F7 for anxiety). 

• Defines reward percentage and sustained reward criteria. 
ii. Z-Score Training 

• Indicates 4 electrode locations for the 4-channel z-score training 
method (e.g., FP1, FP2, F7, F8 for anxiety) 

• Identifies deviant EEG activity found at included electrode sites. 
iii. sLORETA Z-Score Training 

• Provides Brodmann areas that are suggested to include in the 
sLORETA z-score training method together with the specific 
frequency bands to include for the different brain regions. 

b) Scientific Support & Data Quality  

The scientific validity and data quality of the recommended protocol are evaluated based on 
four key factors: 

i. Scientific Support: How well the recommendation aligns with existing 
research on neurofeedback effectiveness. 
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ii. Specificity: Whether the target EEG deviation is spread across many 
electrodes and/or a large frequency band width. 

iii. Degree of Deviance: The extent of abnormal EEG activity based on z-scores. 
iv. Data Quality: A rating of the data quality based on the amount of artifacts 

detected by SARA. 

5. Important Note 

• Neurofeedback Training Should Be Guided by Clinical Judgment 
While the report offers qEEG-informed and scientifically grounded neurofeedback protocol 
recommendations, clinicians should always review them before implementation. 

6.  Substance Use Effects 

a) If applicable, this section highlights substances reported in the questionnaire (e.g., 
medications, drugs). 

b) It explains the short-term and long-term effects of substance use on EEG patterns. 

 

24.    qEEG Comparison Report 

The qEEG Comparison Report allows for a comparative analysis of EEG deviations based on multiple 
EEG datasets. The analysis highlights differences in z-scored surface amplitudes, z-scored surface 
coherence, and sLORETA-based source reconstruction. 

By evaluating changes in EEG activity over time, this report provides valuable insights into the effects 
of interventions or treatments. However, it is important to consider additional factors such as 
recording conditions, sleep patterns, and the presence of artifacts when interpreting results. 

 
1. How to Request a qEEG Comparison Report 

The qEEG Comparison Reports in qEEG-Pro allow you to generate comparative EEG analyses based 
on multiple EEG recordings. Follow the steps below to create and access these reports: 

a) Navigate to the Comparison Report Section 

In the left-hand menu of the web application, click on ‘Comparison Report’. 

b) Initiate the Report Request 

Click on the ‘Request Report’ button located on the right side of the screen. 

c) Select Client 

Choose the client for whom you want to generate the report. 

d) Choose EEG Recordings for Comparison 
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Select two or more EEG recordings to be compared. These recordings can differ in recording 
conditions (e.g., eyes open vs. eyes closed) or be from different time points to evaluate 
changes over time. 

e) Generate the Report 

After selecting the EEG recordings, click ‘Generate Report’. The system will process the data 
and provide a downloadable qEEG Comparison Report. 

 
 
2. Comparison Report: Cover Page 

 

a) Name (optional) 

This field is intentionally left blank so that the user can enter a client ID or client name after 
the report has been downloaded to the user’s computer. 

b) Date of Analysis 

Indicates the date on which the Comparison Report was generated. 

c) Gender and Handedness 

Key demographic details. 

 

3. Comparison Report: Introduction 

 

a) EEG Recording Details  

Information about the EEG amplifier, sampling frequency, and recording duration for the first 

and last EEG that has been analyzed. 

 
4. EEG Deviations Analysis 

The report presents a graphical comparison of the percentage of deviant z-scores in EEG activity. 
Deviations are categorized using the following color-coding system for the following measures: 

a) Surface Amplitude: Represents the strength of brain activity in different frequency bands. 
b) Surface Coherence: Assesses synchronization levels between different brain regions. 
c) Source Amplitude: Similar to the Surface Amplitude, but instead of using the surface 

electrodes to calculate power, it uses the results from the sLORETA analyses. 
d) Source Coherence: Similar to the Surface Coherence, but instead of using the surface 

electrodes to calculate coherence, it uses the results from the sLORETA analyses. 
e) Color Coding:  
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i. Red: Z-score > 2 (extreme deviation) 
ii. Yellow: Z-score > 1 (moderate deviation) 

iii. Blue: Z-score < -2 (extreme negative deviation) 
iv. Green: Z-score < -1 (moderate negative deviation) 

 

25.    Client sensitive information and Data security 
 

1. The qEEG-Pro web application assures that no client sensitive information that may 

accompany your uploaded EEG files will be accessible to third parties.  

 

2. The raw and processed EEG files and the qEEG reports will be stored on the qEEG-Pro 

servers but the qEEG-Pro cannot be held responsible for situations in which the raw data 

or the reports are no longer accessible for the user. The user is recommended to back up 

their EEG files and qEEG reports on a (hard)disk or backup server/webservice. 

 

26.    Instructional Videos, Expert Coaching and Support 
  

For the qEEG-Pro instructional videos library, go to:  

https://www.youtube.com/@qeeg-pro8659 

 

If you need support for the use of the qEEG-Pro Report Service, got to:   

www.qeeg.pro/support/ 

 

 

We also offer qEEG-Pro Expert Coaching if you want to discuss specific clients or when you want to 

go into more detail about specific qEEG-Pro analyses. Dr. Keizer is the creator of the qEEG-Pro web 

application and is available for expert coaching on the following topics: 

 

1. EEG recording quality 

2. Interpretation of qEEG-Pro analyses 

3. Protocol recommendation 

4. Setting up a scientific neurofeedback experiment 

5. Analyzing EEG data using Matlab 

 

If you would like to make use of Expert Coaching, go to: 

https://qeeg.pro/support/expert-coaching/ 

  

  

https://www.youtube.com/@qeeg-pro8659
http://www.qeeg.pro/support/
http://www.qeeg.pro/support/
https://qeeg.pro/support/expert-coaching/
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Appendix 1. S.A.R.A calculation details 
  

1. Epileptiform Episode Detection  

 
The raw data is copied and low-pass filtered with a cutoff value of 6 Hz. The maximum amplitude 
difference within a moving window (1 second duration, 50 percent overlap) is compared with a 
predefined threshold. When the maximum difference surpasses the predefined threshold, the 
segment is marked as containing epileptiform activity. 
 
2. Filtering 

 

The EEG-data is filtered with a high-pass filter of 1 Hz and a notch filter of 50Hz or 60Hz, depending 

of the power line alternating current frequency of the country where the EEG was recorded. 

 

3. Noisy Channels 

 

The raw EEG data is copied and band-pass filtered leaving only high frequencies above 25 Hz and 

below 40 Hz. When the median high-frequency power of a channel is higher than the median high-

frequency power of all channels plus 2 times the standard deviation and the median high-frequency 

power exceeds a predefined threshold, the channel is ignored for further artifact rejection processes 

and it is marked in the SARA report. 

 

4. EEG-segments Containing Artifacts 

 

Detection of eye-blinks is done by constructing a new signal which represents the sum of channels 

Fp1 and Fp2. A moving window of 1/4 seconds (3.1 percent overlap) then compares the average 

amplitude of the window with a predefined threshold. Whenever the average amplitude surpasses 

the predefined threshold, the segment is removed from the raw data of all channels. 

Detection of horizontal eye movements is done by constructing a new signal which 

represents the difference between channels F7 and F8. A moving window of 1/8 second (6.2  percent 

overlap) then compares the average amplitude of the window with a predefined threshold. 

Whenever the average amplitude surpasses the predefined threshold, the segment is removed from 

the raw data of all channels. 

Detection of low-frequency artifacts other than eye-related artifacts is done by applying a 

low-pass filter to the raw data of all channels (< 3 Hz). A moving window of 1/2 seconds (50 percent 

overlap) then compares the average amplitude of the window with a predefined threshold. 

Whenever the average amplitude surpasses the predefined threshold in a certain channel, the 

segment is removed from the raw data of all channels. 

Finally, high-frequency artifacts are detected by applying a high-pass filter to the raw data of 

all channels (>22 Hz). A moving window of 1/20 seconds (15.5 percent overlap) then compares the 

average amplitude of the window with a predefined threshold. Whenever the average amplitude 

surpasses the predefined threshold in a certain channel, the segment is removed from the raw data 

of all channels. 

Detection of flat line artifacts, which indicate a lack of signal variation, is done by analyzing 

the raw data of all channels. A moving window of 1/2 second (50 percent overlap) then measures the 
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standard deviation of the window. If the standard deviation is below a predefined threshold, 

indicating minimal signal variation, the segment is removed from the raw data of all channels. 

 To minimize the introduction of ‘slicing’ artifacts (sudden changes in amplitude resulting 

from the removal of segments containing artifacts), an algorithm was developed that searches for 

the minimal difference between the start and end of a segment containing artifact in a 1/4 second 

window preceding and following that segment. 
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Appendix 1. qEEG-Pro calculation details 
 

1. qEEG-Pro normative database data collection 

 

The qEEG-Pro normative database was constructed by using the resting-state EEG and questionnaire 

data of clients that visited the Neurofeedback Institute Netherlands (NIN) between 2004 and 2013 in 

one of the 10 different Dutch cities the NIN is located (Neurofeedback.nl). The EEG recording and 

questionnaire was done in order to guide subsequent Neurofeedback treatment. All clients signed an 

informed consent form, which stated that their anonymous EEG and questionnaire data may be used 

for research purposes. The questionnaire consisted of 292 questions (each rated from 0 to 8) that 

were directly based on the criteria of 46 DSM psychopathologies (CNC1020©; www.EEG-

Professionals.nl/en/cnc-1020/). The recordings were done using the 19-channel Deymed TruScantm 

EEG amplifier (www.deymed.com). The electrode sites were positioned according to the 

international 10-20 system (see figure below).  

 

 

 

 

Electrode positions and labels used for the resting-state EEG 
recordings of the qEEG-Pro database. 
 

  

 

 

 

 

 

 

 

 

Sampling frequencies of 128 Hz and 256 Hz were used (8% and 92% of the subjects, respectively). 

The EEG recording session consisted of an ‘Eyes Closed’ condition (EC) and an ‘Eyes Open’ condition 

(EO). In the both conditions, the clients sat in an upright position for a total of 10 minutes. The clients 

were instructed to keep their neck and facial muscles relaxed and refrain from making an excess of 

eye movements or eye blinks in the EO condition. A total of 1696 clients completed the 

questionnaire and the EC EEG recording. A total of 1364 clients completed the questionnaire and the 

EO EEG recording. 88(EC) and 21(EO) clients showed epileptiform activity in their EEG recording 

according to the epileptiform episode detection algorithm and were excluded from the qEEG-Pro 

database. The duration of the de-artifacted EEG of 126 (EC) and 112 (EO) clients was less than 1 

minute and were therefore excluded from the qEEG-Pro database. So to summarize, the EEGs of 

1482 (EC) and 1231 clients were included in the qEEG-Pro. Clients ranged from 4 to 82 years of age. 

The figure below shows the age and gender distribution for both the EC and the EO condition. 
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Age and gender distribution of the qEEG-Pro normative database. 

 
 

2. qEEG-Pro EEG preprocessing 

 

The raw EEG data was de-artifacted using S.A.R.A (see Chapter 1 and Appendix 1). An average of 17% 

and 24% of the raw EEG data was rejected in EC and EO conditions, respectively (see figure 15). 121 

and 133 clients had one or more noisy channels (average number of noisy channels, EC: 1.3, EO: 1.3) 

removed in the EC and EO condition, respectively. The data from these channels were not included in 

the calculation of the group means and standard deviations.   

 

 
 

Distribution of the percentage of rejected EEG data using S.A.R.A. 
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3. qEEG-Pro EEG data analysis 

 

All metrics that are described in detail above were applied to the qEEG-Pro database. A total of 150 

subgroups (ages 1-75.5 years, 6 months resolution) were created by selecting 200 subjects that had a 

minimum age difference with the age bin of interest. A regression analysis was performed for all (log-

transformed) metrics, using the log-transformed data from the 47 psychopathologies categories in 

the questionnaire. The residuals of the regression model represent the variance in the EEG data that 

cannot be explained by any of the 47 psychopathologies. These residuals are then used to calculate 

the means and standard deviations for all metrics.  
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Appendix 2. Practical guide for uploading raw EEG 
 

Follow the steps below to start export your EEG file in the EDF format. 

 

For BrainMaster Discovery users: The .edf file is automatically generated by the BrainMaster 

software. 

 

For Deymed TruScan users: Generate an .edf file in TruScan Explorer by clicking on the ‘export file’ 

button. 

 

An options dialog will pop up. Select EDF+ and use the same settings as depicted in the image below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Mitsar users: Go to the main drop-down menu in EEGStudio and select ‘Export to’-> ‘EDF (+) file’ 

(see below). 
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For MindMedia Nexus users: Go to ‘File’ -> ‘Export Session Data’ in Polyman Viewer with the 

‘Output Format’ set to ‘EDF+ format’. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


